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INTRODUCTION

Welcome to Essential Affinity 3 , the third edition of this long-running book, and one that I almost never
wrote .

When Canva acquired Affinity from Serif, there was considerable discussion within the Affinity community
about what might happen next. Many users were concerned that the software would change beyond recogni-
tion or move to a subscription model. Initially, though, very little changed .

Then, on 31 October 2025, everything changed .

Affinity Designer, Affinity Publisher and Affinity Photo were merged into a single application: Affinity 3. It
was a bold step that fundamentally changed the way the software worked. Not only that, but it was now free,
except for a few premium features .

Like many long-time Affinity users, I approached the new version with a mixture of excitement and uncer-
tainty. Although the underlying editing tools were familiar, the interface had changed significantly. In my
opinion, it made the software more difficult for photographers to learn, particularly those coming to Affinity
with little experience .

At that point, I had already begun planning this new edition of the book, but I decided to stop .

Part of the reason was that I could see the software was still evolving. Bugs and stability issues needed atten-
tion, and I wasn’t convinced it was ready for me to recommend to new users. Rather than rush out another
edition, I chose to wait and see how Canva responded .

I’m pleased that I did .

Over time, Affinity 3 became far more polished, confidence within the community gradually returned, and I
reached the point where I felt comfortable continuing with this project .

Then, as I began looking at the learning resources available for Affinity 3, I noticed something else .

Canva has produced an expanding collection of learning materials, though much of it is aimed at designers
and publishers. That’s understandable given the broad audience for the software. But practical teaching of
photo editing remains surprisingly limited. The same is true of the books available elsewhere, many of which
are little more than feature references or, increasingly, AI-generated summaries of the software .
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That was the point where I realised this book still had an important role to play .

But my aim isn’t simply to explain what the tools do. It’s to help photographers understand how to use and
combine them to produce better images. That comes from years of editing photographs, writing about photo-
graphic workflows and using every version of Affinity since the first release .

If you picked up this book expecting an encyclopaedic reference to every menu, tool and feature, you may be
disappointed .

That isn’t what this book sets out to be .

Instead, I’ve deliberately concentrated on what made the previous editions so successful. Rather than
teaching Affinity feature by feature, this book teaches photography editing through a carefully constructed
workflow .

This is important .

Knowing what a tool does isn’t the same as knowing when to use it, why to use it, or just as importantly,
when not to use it. Most books explain individual features. Far fewer explain how those features work
together as part of a complete editing process .

That’s the difference I wanted this book to make .

Throughout these pages, you’ll learn the essential tools and techniques you need to edit photographs in
Affinity 3. More importantly, you’ll learn how those tools fit together into a practical workflow that you can
apply to almost every image or RAW file .

To give a simple example, you won’t just learn how to use the tools in the Develop Filter to process a RAW
file. You’ll also learn why it’s usually better to stop editing at a certain point and switch to the Pixel Studio.
Decisions like these are rarely explained, yet they can make editing both easier and more effective .

My goal is to help you build good editing habits from the beginning .

Good habits make the software easier to understand, help you avoid unnecessary frustration, and provide a
solid foundation if you later decide to explore more advanced techniques. Instead of having to unlearn ineffi-
cient ways of working, you’ll already have a workflow that grows naturally with your skills .

That also explains the title of this book; the word “ Essential”  is there for a reason .

Affinity 3 is an exceptionally capable application, but like most professional software, you don’t need to
understand every feature to produce consistently good photographs. In fact, you’ll probably use only a rela-
tively small proportion of the available tools .

The difficulty for any new user is knowing which tools those are. When you’re unfamiliar with the software,
every button appears equally important. It’s easy to become overwhelmed, spending time learning features
you’ll rarely, if ever, need .

This book removes that uncertainty .

INTRODUCTION
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By concentrating on the essential tools and techniques for photographic editing, you’ll learn faster, build
confidence more quickly and spend your time mastering the parts of the software that really matter .

There’s also another reason this book is structured differently. Most software books divide the application
into individual tools and panels, asking you to remember large amounts of information before you can begin
using the software effectively. But that’s rarely how people learn .

Many readers will have left formal education behind years ago. That doesn’t mean you’ve stopped learning.
Quite the opposite. We all continue learning throughout our lives, but we generally learn best by doing rather
than memorising. That’s why this book is built around practical examples .

But we’ll begin by familiarising ourselves with the Affinity 3 interface. Although this may seem like a slow
start, it’s one of the most important parts of the book. Affinity 3 is highly customisable, which means your
workspace may look quite different from mine or someone else’s .

Imagine trying to follow an illustrated lesson where every screenshot looks different from what you’re seeing
on your own computer. It’s frustrating, confusing and often enough to make people give up. But by taking a
little time to standardise your workspace at the beginning, the rest of the book becomes much easier to
follow .

From there, we’ll edit a single RAW photograph together, developing it into both colour and black and white
images. As each stage of the workflow unfolds, you’ll learn the essential tools and techniques needed to edit
your own photographs with confidence .

By the end of the book, you won’t know every feature in Affinity 3, but you don’t need to .

What you will understand are the parts of the software that matter most for photographic editing, together
with a workflow that will continue serving you long after you’ve completed the final chapter .

Before we begin, there’s one final request .

Please work through the book in the order it’s presented and resist the temptation to skip ahead. Each chapter
builds on the previous one. Once a concept or technique has been introduced, I assume you understand it and
don’t explain it again later. Skipping chapters often means missing something that becomes important
further on .

Work through each example, taking your time, and don’t move on until you’re comfortable with what you’ve
learned. Most people retain new skills far better by doing than by simply reading .

Finally, download the practice RAW file from my website before continuing: https:// lenscraft. co. uk/ useful-
downloads- books/ . Following the examples using the same image will make the lessons much easier to
understand and help you get the greatest benefit from the book .

Once you’ve downloaded the file, you’re ready to begin .

INTRODUCTION
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Mac and Windows Users
The screenshots and illustrations in this book were created using the Mac version of Affinity 3 (June 2026 ).

If you’re using the Windows version, don’t worry. The two versions are very similar, and the examples in
this book should work equally well. Where I’m aware of differences between the two operating systems, I’ve
highlighted them in the text .

When keyboard shortcuts are shown, the Mac shortcut appears first, followed by the Windows equivalent .

Trademarks
Throughout this book, I refer to several companies, products and technologies. Product names, trademarks
and registered trademarks are acknowledged as the property of their respective owners. Any references are
made solely for identification and editorial purposes, and no infringement is intended .

Disclaimer
The techniques and workflows in this book reflect my own experience of editing photographs using Affinity
3. Photography is a creative subject, and you’ll often find there is more than one way to achieve a similar
result. You may discover approaches that suit your own style better, and that’s perfectly fine .

Although I’ve taken great care to ensure the information in this book is accurate at the time of writing,
mistakes can occasionally happen. If you spot something you believe needs correcting, or have any questions
about the material, please email me at robin@ lenscraft. co.uk . I’ll do my best to help .

Thank you for choosing this book, and I hope it helps you enjoy editing with Affinity 3.

INTRODUCTION
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BOOK DOWNLOADS

Having written many books, I’ve learned that many people skip the Introduction and head straight for the
first chapter. If that’s what you’ve done, don’t worry, you’re not alone .

The Introduction does contain some important information about how this book is organised and why it’s
structured as it is. But the most important thing you’ll find there is the download link for the practice RAW
file used throughout the book .

Please take a moment now to download the file before continuing. Following the examples using the same
image is one of the best ways to learn, and it will help you get much more from the lessons in this book .

You can download the practice files from: https:// lenscraft. co. uk/ useful- downloads- books/

Or scan the QR Code below .

This page contains the download links for all my current and previous books. Simply find Essential Affinity 3
in the list and download the accompanying files .

If the download doesn’t work the first time, wait a few minutes and try again. If you still experience prob-
lems, please email me at robin@ lenscraft. co.uk , and I’ll help as soon as I can .
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PART ONE

LEARNING THE FOUNDATIONS

This first part of the book introduces the Affinity 3 editing environment and lays the foundation for the rest
of the workflow. The aim is not to explain every feature or tool in the software. Instead, the focus is on
helping you understand the small set of concepts and controls essential to photographic editing .

One of the biggest challenges photographers face when learning new software is that the interface can feel
confusing and unfamiliar. This is especially true for photographers moving from Lightroom or Photoshop,
where many tools may appear similar but often behave differently. Before you can confidently edit photos,
you need to feel comfortable working in the software itself .

In this part of the book, you will learn how the Affinity 3 interface is organised, how the different Affinity
Studios fit into the editing workflow, and how to work safely using non-destructive editing techniques. You
will also begin to understand foundational concepts like layers, masks, and the basic structure used
throughout the rest of the book .

The chapters in this part of the book are designed to build foundation skills. They establish the workflow and
editing approach used throughout the book and prepare you for the practical editing examples that follow.
Although some of the concepts may initially feel unfamiliar, they quickly become much easier once you
begin applying them in practice .

By the end, you should feel comfortable navigating the software, understanding the core editing workflow,
and preparing images ready for further editing in the Pixel Studio .





ONE

UNDERSTANDING THE
AFFINITY 3 WORKSPACE

This may not feel like an exciting chapter, but it's possibly the most important. If you don't understand the
interface you're working with, you'll never understand or learn the software. For that reason, don’t be
tempted to skip this chapter, even if you have been using Affinity for a while. It really is that fundamental .

Before you can confidently edit your photography, you first need to feel comfortable working inside the
Affinity 3 workspace. This is often one of the biggest challenges photographers face when learning new
editing software. Even experienced photo editors feel apprehensive when the interface looks unfamiliar or
behaves differently than expected .

I personally experienced a lot of frustration and issues when trying to move from Affinity Photo 2 to Affinity
Photo 3. Previously, I knew exactly where to find all the tools and features, but with the new Affinity 3 inter-
face, everything was familiar but different enough to cause me problems. It was extremely hard knowing
where to find things, and I felt like a complete beginner again. It doesn't matter how good a photographer or
how experienced a photo editor you are; if you don't understand the interface, you're going to struggle to use
the software .

If you are moving from Lightroom or Photoshop, you will likely be in a situation similar to the one described
above. You recognise many of the tools and panels in Affinity 3, but the software's workflow and organisa-
tion are often quite different. This can easily lead to confusion, frustration and mistakes .

The aim of this chapter is therefore not to explain every menu, button, or option available in Affinity 3.
Instead, the focus is on helping you understand the parts of the interface most important for photographic
editing, as well as the workflow used throughout this book .

We will also tackle one of the biggest problems for new users learning the software: the illustrations in the
book don't match the ones you see on your computer. Along with this, you will learn how the Affinity 3
workspace is organised, how the different Studios (previously called Personas) fit into the editing process,
and how to work with the panels and tools used most often throughout the book .

By the end of this chapter, you should feel much more comfortable navigating the software and understand
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how the different parts of the workspace fit together. This foundation will make the practical editing exer-
cises in the following chapters much easier to follow and understand .

Launching Affinity 3
Let's start by launching Affinity 3. When the software opens, you should see the interface, which will look
something like the screenshot below, captured on a Mac computer .

This is the Startup dialog, and it contains several useful features. You may also see this screen when using
certain commands from the Affinity menu, so it’s worthwhile becoming familiar with how it works .

In the illustration, three separate areas of control are highlighted. Let’s look at each of these in turn .

The first area (1) is a row of headings which includes options such as Home , Recent , Learn , My Templates ,
and Favourites . When you click one of these headings, the information shown in the lower part of the dialog
changes to match your selection .

For example, if you click the Recent  heading, you will see a list of files you have recently opened in Affinity
3. Another useful option is the Learn  heading. This displays a collection of tutorials which include down-
loadable files that you can use to follow along with the lesson. Although it’s good to see tutorials included
with the software, most are aimed at design work, with relatively little content for photographers .

ROBIN WHALLEY
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The second area (2) contains three icons. On the left is the Home  icon, which displays the dialog exactly as
you see it now. The middle icon opens your computer’s file browser. You can then navigate to a folder on
your hard drive and select the photo you want to work with. If you decide not to open a file, simply click the
Cancel  button in the file browser, and you will return to the Startup dialog .

The final icon shows a green plus symbol. Click this to create a new, empty document. You will then see a
range of document sizes and presets that you can choose from. Once you select the option you want, Affinity
will create a new blank document ready for you to work with. You can see an example of this in the screen-
shot below .

As you may already have realised, many of these page sizes and document settings relate more closely to
using Affinity 3 for publishing and page layout work. But that’s not to say you won’t use them. For example,
there may be occasions when you want to create a page design containing multiple photographs. Building
this as an A4 layout might be the perfect solution .

There is another important point to understand. Affinity 3 treats photographs as documents. Most of the time,
you will simply open a photograph directly from a file, without needing to create a separate document first.
But when you open an image this way, Affinity automatically places it on a document that matches the
image's dimensions exactly .

This is worth remembering because it helps explain some of the behaviour you will see later in the book.
Once you realise the image is on a document canvas, some features of the software become easier to grasp .

The third area highlighted in the Startup dialog (3) contains your account information. This is the Canva
account you created when registering your Affinity software .

ESSENTIAL AFFINITY 3
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This section is particularly important if you previously used Affinity Photo 1 or Affinity Photo 2. Your
account will provide access to earlier Affinity purchases you may have made from the Affinity store. Before
Canva acquired Affinity, Serif operated an online store where users could purchase additional resources such
as fonts, brushes, and photographic overlays. Many of these resources continue to work perfectly well in
Affinity 3.

If you want to install any of these items, click the small downward-pointing arrow shown beside your
account information. You can see this highlighted in the following screenshot .

When you click the small dropdown arrow, Affinity displays a menu containing several options. These
include switching between accounts (if you have more than one), deactivating your licence, and viewing
your account settings. Many of these options will open pages on the Canva website .

If you want to access purchases from earlier versions of Affinity, open the Advanced  menu and select
Manage Purchased Content . This opens a dialog showing any previous purchases linked to your account.
From here, you can download and install those items into your current version of Affinity 3.

You will probably recognise this dialog if you previously used Affinity Photo 2, as it is largely the same
interface that appeared there .

Now let’s open an image and take a closer look at the Affinity 3 interface design .

Exploring The Affinity 3 Interface
Start by clicking the folder icon in the top-right corner of the Startup dialog. In the previous section, we saw
that this icon opens your computer’s file browser .

You should now see the Open File  dialog, which lets you navigate to the image you want to work with. For

ROBIN WHALLEY
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this exercise, open any JPEG or TIFF file you have available, but do not use a RAW, DNG or other file
formats. I’ve used the Chapter 1 JPEG  image supplied with the course for the illustrations in this chapter .

Select the file and then click the Open  button. The image should now appear in the Affinity interface. In a
moment, we’ll look more closely at the different parts of the interface, but first, I want to highlight an impor-
tant point .

Many readers will be tempted to open the image in a different way, such as by double-clicking the file in a
folder on their computer. I recommend that you avoid doing this, especially while learning the software .

Over the years, I’ve received many support emails from readers explaining that the practice files supplied
with my books will not open correctly in Affinity. Instead, the files may open in a different application or
sometimes fail to open at all. In almost every case, this happens because the file type has become associated
with another program installed on the computer .

This can occur quite easily. Some applications automatically make themselves the default editor for file types
such as JPEG images during installation. At other times, it happens when people experiment with settings on
their computer without realising the effects this can have later. Because of this, the behaviour can seem
confusing and unpredictable. Opening files from inside Affinity, using the method explained above, avoids
this problem and ensures that the image opens in the correct application .

You should now see the image displayed in the Affinity interface, as shown in the following screenshot .

ESSENTIAL AFFINITY 3
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There’s a lot happening on this screen, so I’ve numbered the main areas to make them easier to identify and
discuss. Let’s go through each one in turn .

At the top of the screen is the main menu system (1). Although it may not look especially complicated at
first, the menu structure is actually quite extensive. Some commands are hidden several levels deep, which
can make them slower to access and more difficult to reach while you are editing .

Because of this, you will often find it quicker to work using shortcuts, toolbar icons, and the Studio panels
that we will look at shortly. These provide faster access to many of the commands you use regularly. This
can help you to work more efficiently without constantly searching through menus. It’s the approach we will
take throughout this book .

The next area is the Studio toolbar (2). Affinity uses a concept called Studios . You can think of these almost
as separate working environments within the same application. Each Studio is designed for a particular type
of work .

For example, the Pixel Studio  is where we handle most of our photo editing. The Vector Studio  contains tools
for creating vector-based artwork and graphic designs. The Layout Studio  focuses on page design and docu-
ment layout. In practice, it can feel a little like working with three separate applications, all within Affinity 3.

You will also notice other Studios in the toolbar, such as Slice , Canva AI , and Retouching . Each of these is
designed for a specific purpose and includes its own collection of tools and controls .

ROBIN WHALLEY
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One thing that can initially seem confusing is that many of the same tools and panels appear in multiple
Studios. In most cases, these tools behave in exactly the same way regardless of which Studio you are using.
Because of this, it’s usually best to become comfortable working mainly in the Studio that matches the type
of work you are doing .

For this book, we will mainly use the Pixel Studio  for our photo editing .

It’s also possible to hide or display the different Studios shown in the toolbar. To do this, click the three-dot
icon at the right-hand end of the toolbar. You can see this highlighted in the following screenshot .

In the screenshot above, you can see that many of the Studios are currently enabled and displayed in the
Studio toolbar. Then, further down the list, some Studios like the Compositing Studio  are disabled and there-
fore hidden from view .

Affinity also lets you create a custom Studio arrangement by clicking the Create Studio  button. Although this
can be useful at times, I don’t recommend experimenting with custom Studios until you feel more comfort-
able using Affinity 3 and understand how the interface is organised .

You may also notice that the Studio toolbar is only part of the toolbar area across the top of the interface. To
the right of the Studio controls is the main toolbar, which can also be customised to show or hide different
icons. Because of this, your interface may not look exactly like the screenshots shown in this book .

Next, we have the Tools Palette  (3) on the left side of the interface. This contains a large collection of editing
tools. Many of these we don’t need, but we will be using some of the most valuable later in the book as we
work on photographs .

Like many other parts of the Affinity interface, the Tools Palette can also be customised. Tools can be
hidden, rearranged, or displayed differently, so your palette may not match my screenshot .

ESSENTIAL AFFINITY 3
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The tools are represented by icons, but some of these icons hide groups of related tools beneath them. Only
one tool from a group can be displayed at a time. You can identify these grouped tools by looking for the
small arrow in the bottom-right corner of the tool icon. We will explore these grouped tools in more detail as
you progress through the exercises in this book .

Next, we have the Context Sensitive Toolbar  (4) at the top of the interface. The controls displayed here
change depending on which tool is currently selected in the Tools Palette on the left .

This toolbar is extremely important because it controls how the selected tool behaves. Many of the editing
tools in Affinity rely heavily on the settings in the toolbar. It’s also worth understanding that the default
settings are not always ideal for photographic editing. As a result, learning to recognise and adjust these
controls is an important part of working successfully in Affinity 3.

You will also find that many tools share similar controls in the Context Sensitive Toolbar. Brush-based tools
are a good example of this. These tools often include controls to adjust a brush's size, hardness, flow, and
opacity. Once you become familiar with these controls in one tool, you can apply the same understanding
when using tools from the same ‘family’ throughout the software .

Next, we will look at the status bar (5) located at the bottom-left corner of the interface. Many of the icons
shown here relate more to page layouts and other non-photographic features within Affinity 3. There is,
however, one part of this area that is particularly important .

When you select a tool from the Tools Palette, this section of the interface displays additional information
and guidance relating to the selected tool. This can include useful hints, keyboard shortcuts, or details about
how the tool behaves .

You can see a couple of examples of this in the following screenshot .

The icon on the left represents the tool selected in the Tools Palette. The status bar information next to this is
what appears at the bottom of the interface when that tool is selected. The information displayed in this area
can provide useful tips about the tool and how to use it. It may also display special keyboard shortcuts known
as modifier keys .

Modifier keys are keys such as Shift , Option , and Command  on a Mac, or Shift , Alt , and Ctrl  on a Windows
PC. By holding down one of these keys while using a tool, you can change or modify the way the tool
behaves or unlock additional functions. As you work through the exercises in this book, you will see several
examples of this .

The final part of the interface we need to examine is what are called the Studio panels (6). You can see these
panels arranged along the right-hand side of the interface .

ROBIN WHALLEY
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Studio panels are essentially collections of related tools and controls grouped together into small working
panels. They provide quick access to many of the features you will use while editing your photographs.
Affinity includes many Studio panels, but we will only need a small selection for photographic work .

One of the strengths of the Studio panels is their flexibility. You can rearrange them, group them together,
resize them, or move them to different parts of the interface. This makes it much faster and easier to access
the controls you use regularly .

Unfortunately, this flexibility can also make the interface feel confusing for new users. In the past, it was
quite common for Studio panels to change position after an Affinity update, or for panels to be accidentally
moved, resized, or closed while experimenting with the interface. Because of this, it’s important to under-
stand how to customise and restore the panels when necessary .

We’ll look at how to do that next .

Customising the Studio Panel Layout.
The first thing I would like you to do is save your current workspace layout. This stores the existing arrange-
ment of your panels and tools exactly as they appear now .

The reason for doing this is simple. During the next exercise, we will make changes to the workspace, and
saving the layout now means you can easily return to your current arrangement afterwards if you wish .

To save the layout, open the Window  menu, then choose the Panels  submenu, and then select the Add
Preset… option .

A small dialog will appear asking you to enter a name for the new preset. Enter the name Temp Layout .

Once you have entered the name, click the OK  button to save the preset. The dialog will then close .

If you now return to the Window  menu and open the Panels  submenu again, you should see the new Temp
Layout  preset listed near the top of the menu, as shown in the following screenshot .

ESSENTIAL AFFINITY 3
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We have now saved the current workspace layout as a preset, which means we can restore it at any time. To
apply a saved preset, simply click its name in the menu list .

If you try this now using the “Temp Layout” preset, you will notice that nothing appears to happen. That’s
because the current workspace layout hasn’t been changed yet. We’ll do that next .

Return to the Window  menu and then open the Panels  submenu again. This time, click the Reset  option (at
the bottom). This will reset the workspace layout .

Your workspace has now been restored to the default Affinity layout. Depending on how your copy of
Affinity was previously configured, this layout may look different from the one you were using before. The
important point is that we are now all working with the same layout as shown in this book .

Next, we need to look more closely at how the Studio panels work. Understanding this will also help you
understand how other parts of the Affinity workspace can be customised and arranged .

If you look carefully at the right-hand side of the interface, you will see that the Studio panels are organised
into three separate groups. Each group can contain one or more Studio panels. I’ve highlighted these groups
in the following screenshot .
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Although the screenshot shows three groups of Studio panels arranged vertically, you are not limited to this
layout. Depending on how you organise the interface, you may have more or fewer than three groups. For
simplicity, we will work with three groups in this book .

If you look at the middle group now, you will see several Studio panels arranged as tabs. In the screenshot,
these are Layers , Channels , Brushes , and Stock .

We will regularly use the Layers  and Channels panels , and potentially Brushes  while editing photographs, so
we will leave those in place. The Stock  panel, however, is something we are unlikely to use very often. Our
focus in this book is on editing our own photographs rather than searching for stock images. As a result, we
can safely remove the Stock  panel from the group, and you will also learn a little more about how Studio
panels behave .

Start by clicking the Stock  tab to make it active. Notice how the tab changes appearance to show that it is
selected, and the contents of the Stock  panel are now displayed below the tab .

Next, we will move the Stock  panel out of the middle group. To do this, click and hold the Stock  tab with
your mouse, then drag it towards the centre of the screen. Once it is away from the group, release the mouse
button .

You should now see the Stock  panel floating independently in the middle of the workspace. Any Studio panel
in Affinity can be used in this floating style. This allows you to position it wherever you find it most conve-
nient. Alternatively, panels can be docked into the grouped panel areas on the interface's sides. These were
called the Left and Right Studio areas in earlier versions of Affinity, but are now just referred to as Left and
Right .
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To move either a floating panel or a docked panel into a different group, simply click and drag the panel by
its tab. As you drag it over another group, you will see Affinity highlight where the panel can be placed.
When you release the mouse button, the panel will dock into that group and appear as a new tab .

You can see an example of the Stock Panel both floating and docked in the following screenshot .

Let’s now hide the Stock  panel. This is easiest to do while the panel is floating. If your Stock  panel is
currently docked into a group, click and drag it out into the workspace so that it becomes a floating panel
again .

Once the panel is floating, you will see a small close icon in the top-left corner. Click this once to close the
panel and remove it from the interface .

Another panel that we are unlikely to use very often in this book is the Transform  panel. You should find this
in the bottom group of the Studio panels .

This time, rather than closing the panel as a floating panel, we will use a different method .

Start by clicking the Transform  tab to make the panel active and display its contents. Next, look towards the
right-hand side of the panel group, where you will see a small downward-pointing arrow icon. Click this to
open a pop-up menu .

From this menu, choose the Close  option. The Transform  panel will then close and disappear from the
interface .
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You have now closed both the Transform  and Stock  panels. This should leave seven panels still visible,
arranged across the three panel groups :

In the top group, you should see the Histogram  and Colour panels .
In the middle group are the Layers , Channels , and Brushes panels .
In the bottom group are the Navigator  and History panels .

These are the panels we will use most frequently while editing photographs throughout this book .

Let’s now save this arrangement as a new workspace preset called Essential Affinity .

As before, open the Window  menu and then the Panels submenu .

From the submenu, choose Add Preset…  to display the dialog for entering a preset name .

Enter the name Essential Affinity , then click the OK  button to save it .

If you now return to the Window  menu and open the Panels  submenu again, you should see the new Essential
Affinity  preset listed alongside the earlier Temp Layout  preset. Try switching between the two presets and
observe how the interface changes .

There is also another useful way to show or hide panels in the interface. If you look again at the panel drop-
down menu shown in the previous screenshot, you will notice an option near the top called Panels ….

Clicking this opens a small dialog listing all the available Studio panels for the Pixel Studio . You can then
turn panels on or off simply by selecting them in the list. This provides a quick and convenient way to
customise the workspace without needing to drag panels around manually. You can see a screenshot of the
Panels dialog below .

As Affinity now includes a very large number of Studio panels (after the three Affinity applications were
combined), the Panels  dialog has a useful search feature at the top. As you begin typing the name of a panel,
the list is automatically filtered to show only matching results. This makes it much quicker and easier to find
a specific panel you want to show or hide .

It is also possible to show or hide panels using the main menu system .
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If you open the Window  menu at the top of the Affinity
interface, you will notice another set of items below the
Panels  submenu we have been using .

In earlier versions of Affinity, all panels were listed
directly in this menu as one long list. Unfortunately,
Affinity 3 now has far too many panels to display clearly
in that way. To make the menu easier to manage, the
panels are now organised into groups. The disadvantage is
that this can make it difficult to find the panel you need
unless you know which group it belongs to. For this
reason, the Panels  dialog is usually the easier option when
you want to display a hidden panel .

Let’s look at how this works .

To display a panel that is currently hidden, open the panel
dropdown menu and choose the Panels…  option. When the dialog appears, click in the search field at the top
and enter the word Assets .

As you type, the list will filter automatically to show only the Assets  panel. To the right of the panel name,
you will see a toggle switch. Click this switch once to make the panel visible .

As soon as you do this, the Assets  panel should appear on the left side of the interface .

It’s also useful to understand that turning a panel on or off does not close the Panels  dialog itself. The dialog
remains open, allowing you to continue showing or hiding other panels if required. You can even work with
the panels while the Panels dialog is open. Once you have finished, simply close the dialog window .

You should now see the Assets  panel displayed on the left side of the interface, while your other Studio
panels remain on the right. The contents of the Assets  panel will vary depending on any assets you may
already have installed in your copy of Affinity .

You can see an example of my layout in the screenshot below .
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What we now see are two separate Studio areas : one on the left side of the interface and the other on the
right. Both areas can contain docked Studio panels, and some panels will appear on either the left or right
side by default .

Another important feature of the Studio areas is that they can be shown or hidden independently. These
controls are found in the Window menu .

Open the Window  menu and then the Panels  submenu. Here you will see options labelled "Show Left"  and
"Show Right ".

Whenever a Studio area is visible, a tick mark appears beside its menu option. For example, because both
Studio areas are currently visible, you would see tick marks beside both Show Left  and Show Right in the
menu .

If you click the Show Left  option, it toggles the left Studio area off. The Assets  panel will then disappear from
the interface, even though it is still technically enabled .

Try this now by hiding the left Studio area. Afterwards, reopen the Panels  dialog and look for the Assets
panel in the list. You should see that the panel is still marked as visible, even though it no longer appears on
screen .

Once you have confirmed this, click the Show Left  option again in the Window > Panels  submenu. The left
Studio area should reappear, together with the Assets panel .

This behaviour can sometimes be confusing for new users, which is why I wanted to highlight it here .
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Another common source of confusion is that it is possible to hide both the left and right Studio areas simulta-
neously without closing any Studio panels .

To see this, open the Window  menu and then the Panels  submenu again. Below the Show Left  and Show
Right  options, you will find the Hide  option. Click this once to activate it .

All the Studio panels will now disappear from the interface .

If you open the Window > Panels  submenu again, you will notice that the Hide  option now has a tick mark
next to it, indicating it is active. Click the option once more to turn it off, and the Studio panels will reappear .

Although Studio panels include a few other features, we do not need to explore them further at this stage.
Instead, let’s move on to the Tools Palette , as it is another part of the interface that can be customised and is
often a source of confusion .

Customising the Tools Palette
There are a couple of ways to customise the Tools Palette . The first involves changing which tools are
displayed and the order in which they appear .

If you look at the bottom of the Tools Palette on the left side of the interface, you will see an icon containing
three dots. Click this icon to open a dialog showing all the available tools in Affinity .

You can see an example of the dialog in the following screenshot .
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When the dialog is open, there are several things you can do to customise the Tools Palette .

The first is to change the order of the tools. To do this, click and hold one of the tool icons in the Tools
Palette, then drag it to a new position. As you move the icon, the other tools will rearrange themselves to
make space. This allows you to create a custom tool order that better suits the way you prefer to work .

Once you are finished, simply close the Customise Tools  dialog. Your new tool arrangement will remain in
place .

You can also use the dialog to add or remove tools from the Tools Palette .

To remove a tool, click and drag the tool icon from the Tools Palette into the Customise Tools  dialog window,
then release the mouse button. The tool will disappear from the palette .

To add a tool back again, click and drag the tool icon from the dialog onto the Tools Palette. When you
release the mouse button, the tool will be added to the palette. You can also add separator bars in the same
way to help organise the tools visually .

Because Affinity now includes a very large number of tools, the Customise Tools  dialog also includes
features to help you locate tools more easily .

At the top-left corner of the dialog is a dropdown menu that allows you to filter tools by category. The tools
are organised into logical groups, making it easier to browse only the tools related to a particular type of
work .

If you already know the name of the tool you are looking for, an even quicker option is to use the search
field. Click inside the search box and begin typing the tool name. The list will automatically filter to display
only matching tools .

Another useful option in the dialog is the ability to change the number of columns used in the Tools Palette.
This control is found towards the top-right corner of the dialog. By default, the Tools Palette displays tools in
a single vertical column, but you can increase the number of columns to create more space .

Finally, the dialog also includes an option to reset the Tools Palette back to its default configuration .

When you are first learning Affinity 3, I strongly recommend leaving the tools in their default arrangement,
or resetting them if they have already been changed. Doing this makes it much easier to follow tutorials,
exercises, and screenshots, as the tools will appear in the same locations throughout the book .

Now let’s look at another customisation option: changing the way the tools are displayed in the Tools Palette .

To access these options, simply right-click anywhere on the Tools Palette itself. A small pop-up menu will
then appear, similar to the one shown in the following screenshot .

Let’s quickly look through the options in this menu, as many people accidentally change these settings and
then become confused about why their interface suddenly looks different .

Hide Tools
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This option completely hides the Tools Palette and all its
contents. If you activate this accidentally, the easiest way
to restore the Tools Palette is to open the View  menu at the
top of the interface and then use the Tools  submenu to
display it again .

Dock Tools

This option controls whether the Tools Palette is docked to
the left side of the interface or displayed as a floating
palette. Clicking the option toggles the setting on or off .

When docking is disabled, the Tools Palette behaves like
the floating Studio panels we examined earlier, allowing it to be moved freely around the workspace. You
can also access this setting from the View > Tools submenu .

Hide Sub Tools

This option controls one of the more noticeable interface changes introduced in Affinity 3, and it tends to be
a feature that people either love or hate .

In earlier versions of Affinity Photo, many tools were grouped together under a single icon in the Tools
Palette. To access the other tools within a group, you needed to click the small arrow in the bottom-right
corner of the icon. Another option was to click and hold the mouse button on the tool icon for a few seconds
until the group expanded .

Once the group was displayed, you could select the tool you wanted to use, and its icon would then replace
the previous icon in the Tools Palette .

Affinity 3 introduced a new feature called the Sub Tool toolbar . When this feature is enabled, a floating
toolbar appears beside the Tools Palette. Whenever you select a grouped tool, the related Sub Tools are
displayed automatically in this floating toolbar .

The following screenshot shows both interface configurations. The floating toolbar is shown in the screen-
shot on the right .
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Personally, I prefer to keep the floating Sub Tool toolbar turned off, which is why it is hidden in the earlier
screenshots. There are two reasons for this. First, I have spent many years editing with earlier versions of
Affinity Photo, so the older behaviour feels more natural to me. Second, I find that the floating toolbar can
sometimes get in the way when editing images, particularly on smaller screens .

Rich Tool Tips

Rich Tooltips are another particularly useful feature, especially for people who are new to Affinity 3. For this
reason, I recommend leaving this option enabled. If it is currently turned off, it’s worth switching it back on .

When Rich Tooltips are enabled, you can move your mouse pointer over a tool in the Tools Palette, and an
information panel will appear beside it. This panel explains what the tool does and lists any modifier keys
that can be used to access additional features or change the tool’s behaviour .

The information shown here is similar to the guidance displayed at the bottom of the interface, as we
discussed earlier. The advantage of the Rich Tooltips system is that the information appears directly beside
the tool you are using, making it easier to understand and remember .

You can see an example of a Rich Tooltip in the following screenshot .

Panning and Zooming
Now let’s look at how to move around an image, as this is
something you will do constantly while editing
photographs .

When an image is first opened, Affinity usually displays it
at a magnification level that fits the image within the avail-
able screen space. To change this magnification level,
several options are available .

The two methods you will probably use most often are the Zoom Tool , found in the Tools Palette on the left
side of the interface, and the Navigator panel .

Let’s begin with the Zoom Tool . You can identify this by its magnifying glass icon in the Tools Palette .

Using the Zoom Tool

When you select the Zoom Tool, several controls appear in the Context Sensitive Toolbar at the top of the
interface. These controls allow you to change how the image is displayed and navigated .

You can see the Zoom Tool and its controls highlighted in the following screenshot .
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When the Zoom Tool  is active, you can zoom in on an area of the image simply by clicking it. Each time you
click, Affinity increases the magnification and centres the view around the point you selected .

You can also zoom out using the same tool. To do this on a Mac, hold down the Option  key while clicking
the image. If you are using a Windows PC, hold down the Alt  key instead .

There are several additional Zoom shortcuts available when using the Zoom Tool. Rather than trying to
memorise all of them immediately, it’s often easier to refer to the Rich Tooltips  by hovering your mouse over
the tool in the Tools Palette or using the information bar at the bottom of the interface. This displays the
modifier keys available for the currently selected tool .

When the Zoom Tool is selected, you can also use the controls in the Context Sensitive Toolbar at the top of
the interface .

On the left side of the toolbar is a dropdown menu containing several commonly used zoom levels. You can
click this menu and choose the magnification level you want to use .

To the right of the dropdown is a zoom slider. Dragging the slider to the left reduces the magnification, while
dragging it to the right increases it .

There is also a units dropdown in the toolbar. This setting is not particularly important for zooming itself, and
for now, I recommend leaving it set to Pixels . Doing this will help avoid confusion later in the book when we
discuss image dimensions and measurements in more detail .
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Using the Navigator Panel

The Navigator  panel is a specialised Studio panel designed specifically for zooming and moving around an
image. By default, you will find it in the bottom panel group on the right-hand side of the interface .

Select the Navigator  panel, and you should see its zoom and navigation controls displayed, as shown in the
following screenshot .

At the top of the Navigator  panel is a zoom slider that can be dragged left or right to adjust the image's
magnification. This works in much the same way as the zoom slider we saw earlier in the Context Sensitive
Toolbar .

As you adjust the slider, the current zoom level is displayed to its right. In the above screenshot, the image is
displayed at 150% magnification .

You can also click this percentage value and enter a new number. This is useful when you quickly want to
zoom to a specific magnification level .

On either side of the slider are plus and minus buttons. Clicking these increases or decreases the magnifica-
tion in fixed steps .

Once the image is zoomed in beyond the screen size, a small blue rectangle appears over the thumbnail preview
in the Navigator panel. This rectangle represents the visible area of the image in the main editing window .

There are two simple ways to use this rectangle to move around the image .
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The first method is to click directly on a point in the thumbnail preview. When you do this, the blue rectangle
moves to the new location, and the main image view updates to match .

The second method is to click and drag the blue rectangle itself. This allows you to smoothly pan around
different parts of the image. When dragging the rectangle, it is usually easier to click inside the blue box
rather than trying to grab its edges .

Other Panning Features

The Navigator panel is not the only way to move around an image. Another option is the View Tool , which
appears as a hand icon in the Tools Palette. By default, this tool is positioned just above the Zoom Tool .

When the View Tool is active, you can click and drag directly on the image to pan left, right, up, or down .

There is also a very useful keyboard shortcut worth remembering. If you are using another tool, such as the
Zoom Tool, and want to temporarily pan around the image, simply press and hold the Spacebar . This
temporarily switches to the View Tool, and the mouse pointer changes to a hand icon .

While holding the Spacebar, you can click and drag to move around the image. When you release the Space-
bar, Affinity automatically switches back to the tool you were previously using .

Let’s finish this section by looking at two additional features that can make navigating around an image
easier .

The first relates to the pointing device you are using. Some devices include built-in gestures that allow you to
scroll around an image or zoom in and out very quickly. A good example is the Apple Magic Mouse .

By moving your finger across the top surface of the Magic Mouse, you can pan around the image smoothly
and quickly. Features like this can save a surprising amount of time once you become comfortable using
them .

There is, however, one small downside. Because the surface of the mouse is touch-sensitive, it’s quite easy to
move the image accidentally simply by brushing the mouse with your finger. This can sometimes feel frus-
trating at first, but once you understand why it is happening, it becomes much easier to recognise and avoid .

The second feature I want to mention is how to quickly return the image so that it fits the screen area, just as
it did when you first opened it .

If you explore the various zoom controls we have discussed so far, you may notice that none of them
provides an obvious way to return to this “fit to screen” view. There are a few solutions, but they are slightly
hidden .

To try this for yourself, first zoom the image to around 150 %.

Next, look at the Layers Studio Panel , where you will see your image listed as a Background  layer. To the
left of the layer name is a small thumbnail preview of the image .

You can see this highlighted in the following screenshot .
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Once you have located the layer thumbnail, double-click it. Affinity will immediately zoom the image to fit
within the available screen space, while also centring it in the workspace .

This is a very useful shortcut to remember. It provides a quick way to recover the image if you have
zoomed in heavily or panned away from the photograph and can no longer easily see where you are
working .

Although this is an excellent solution to a surprisingly common problem, it’s important to be aware that
double-clicking a layer can sometimes trigger different behaviour depending on the type of layer you are
working with. We will encounter one example of this later in the book when we begin working with RAW
files .

There are also two other alternative methods you can use. The first is the keyboard shortcut Cmd + 0 on a
Mac. If you’re using a Windows PC, that’s Ctrl + 0. The second is in the View menu at the top of the inter-
face. Here you will find the Zoom submenu where one of the options is “To Fit”. Both of these methods will
ensure that the image is displayed at maximum magnification, with no part hidden .

Understanding the Old Personas
Earlier in this chapter, I briefly mentioned that older versions of Affinity used a feature called Personas ,
which has now been replaced by Studios . If you previously used earlier versions of Affinity Photo, you may
initially find this change a little confusing, as there is no simple one-to-one relationship between the old
Personas and the new Studio system .
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END OF SAMPLE

To continue reading, this book can be purchased from the Lenscraft 
website by visiting:

https://lenscraft.co.uk/project/essential-affinity-3-book/


